Welcome to Easy Plan 5.0!

This manual introduces you to Easy Plan,™ a drawing program for creating pre-fire and site diagrams. It explains how to get help with the program, program basic concepts, and includes a basic tutorial designed to get you drawing quickly.

How to Contact Us
Feel free to contact The CAD Zone with any questions:

The CAD Zone web site at: http://www.cadzone.com

Email Support: info@cadzone.com

Phone Support: (503) 641-0334  Fax: (503) 641-9077
Monday – Friday, 8:00 a.m. – 5:00 p.m. PST

System Requirements
To use Easy Plan you must have a computer with a Pentium IV or better central processor, running Microsoft Windows XP, Windows Vista or Windows 7. You must have at least 1 GB of RAM and 5 GB of free hard disk space. The minimum screen resolution is 1024 x 768 pixels.

Copyright Laws Apply!
All CAD Zone software is protected by international copyright laws. You probably know you can’t legally make a copy of someone’s book (if it is protected by a copyright) and give it to everyone in your department or company. The same protection applies to software. When you purchase a copy of Easy Plan, you are actually purchasing a license to use the program on ONE computer.

Each purchased copy of the software may be installed only on a single computer.

This means you can obtain one Access Key, which allows you to license the software on one computer for each copy of the software you purchase. The CAD Zone’s complete license Agreement is printed on the envelope that contains your program CD.

Install First – Then License Your Software
Separate Installation instructions are included in this software package. Follow those instructions to install your program. You can only license your program AFTER IT IS INSTALLED onto your computer.

When you first install the program, it will be in Evaluation Mode. This means you can open the program 10 times and have access to all of the program features. After those 10 times you can still open the program and try it out, but you will not be able to save your diagrams until you complete the licensing of your new software. To license your program for unlimited use, you must obtain an Access Key from The CAD Zone and enter it into the program.
The Access Key is unique to each computer - Call, email, or go online to receive your Access Key.

Before you can obtain an Access Key, you must purchase the program. The CAD Zone must have received a Purchase Order from your government agency or have successfully charged your credit card.

Find Your Computer ID
Each time you open the program, a Registration dialog box is displayed that prompts you to enter an Access key. You can also bring up this dialog box at any time with these steps.

1. Open the program and select the Help pull-down menu.
2. Select License

Once the Registration dialog box is displayed, you will see the Computer ID for your computer. You must provide this Computer ID to The CAD Zone so we can generate your unique Access Key. This Access Key will ONLY work on the computer with the matching Computer ID. Once you enter your Access Key, your program will be fully licensed and you have unlimited access to all the features.

To License Your Software Online
When you purchase your software you will receive an email notice with information on how to log onto the CAD Zone website and obtain your access key, including a user name and a temporary password

1. As instructed in the email, go to: http://www.cadzone.com/license and log in to your customer account.
2. Once you log in, you will be sent to the “Get Keys” webpage. Choose the product you wish to license and enter the particular computer’s ID from the License dialog box.

Follow the instructions on the site to obtain your access key and enter it into the registration dialog box in the program (described above).

To License Your Software Via Email
1. Open the program, select the Help pull-down menu, and then select License to bring up the Registration dialog box, as described above.
2. Click the button “Get Access Key Via Email.”
3. Enter your customer information in the form that is displayed.
4. Click “Submit Email request for Access Key.” Your Access Key will be emailed to you, normally on the next business day.

To License Your Software by Phone, Monday – Friday, 8:00 am to 5:00 pm, Pacific Time
1. Open the program, select the Help pull-down menu, and then select License to bring up the Registration dialog box, as described above.
2. Call The CAD Zone at 800-641-9077 and give us your computer ID.
3. We’ll generate your Access Key and read it back to you over the phone so you can enter it into the Registration dialog box.
Training Materials
Most Easy Plan users teach themselves how to draw by working through the available tutorials and training movies. Easy Plan includes many resources that can help you learn to use the program, including the Learning Center, the electronic help, movies, and tutorials.

The Learning Center
The Learning Center is the first place to go for help with the program. There are a variety of training materials here, including tutorials for those just getting started and tips and tricks for using the most complex features. The Learning Center provides you with shortcuts to “How Do I?” topics, tutorials, step-by-step movies, electronic help, and helpful web links.

Electronic Help
The electronic help (accessed from the Help pull-down menu), contains step-by-step instructions for commands used in the program and instructional tutorials.

The Learning Center Movies
A number of instructional movies are included on the program DVD that provide step-by-step instructions for many of the program commands. If you do not have access to the program DVD, the training movies can also be viewed from the training section of The CAD Zone’s website, described below.

CAD Zone Training Web Site
The CAD Zone’s training website contains tutorials, user’s manuals, training movies, and other documentation. To enter The CAD Zone’s training web site,

1. Go to: www.cadzone.com and select the Training button
2. Or go directly to http://training.cadzone.com

Free Technical Support
The CAD Zone offers free telephone and email technical support. You can receive Email support by submitting your questions to: info@cadzone.com. Telephone support is available by calling:

(503) 641-0334, Monday-Friday - 8 a.m. to 4:30 p.m. Pacific Time
Program Basics

Before you start drawing, it’s a good idea to understand some things about how Easy Plan works, such as compatibility, vector objects, drawing scale and satellite images.

Compatibility
The Easy Plan program will allow you to save to .BMP, .WMF, .PDF, and .JPEG formats for easy placement into text documents.

Vector Drawing Vs. Bitmap
Easy Plan is a “vector-based” drawing program, meaning you construct your diagram by creating objects such as lines, circles, rectangles, text, colored fills, and so on. This method is best for drawing floor plans and site plans because you can draw to actual measurements and maintain accuracy.

Since everything is constructed of objects, it’s very easy to edit your diagrams. For example, if you want to move a line or symbol, you simply click on it and move it. You can also import Satellite Images from Microsoft’s Bing™ Maps and draw on top of the image for a fast way to create a pre-fire plan diagram.

Always Draw At 1 to 1 Scale
You never have to calculate a drawing scale when you draw. In Easy Plan you draw everything to the actual measurements that you took at the site. In other words, you use a 1 to 1 scale. We expect to scale our drawings to fit on a piece of paper, but the computer doesn’t have that restriction! Think of it like drawing on a sheet of paper that is infinitely large. If you want to draw a building that is 200’ x 150’, you tell the program to create a rectangle with those exact measurements.

Once an object is drawn, its size never changes (unless you choose to scale it) so accuracy is always maintained. You can zoom in on an area of your drawing to make an object look larger on the computer screen, but that just changes the display, not the actual size of the objects. It’s like using a camera with a zoom lens. You only have to set a drawing scale when you want to print your diagram.

The Program Screen
Throughout this manual, we will refer to various portions of the program screen. It’s very important that you know where to find the Speedbar, the Left-hand toolbox, the Message Bar, and so on. Important sections of the program screen are identified below.

Tip: Whenever you’re not sure what to do next, look at the Message Bar at the bottom of the program screen! The simple prompts given on the Message Bar will help you learn to draw easier and faster.
Keyboard Shortcuts

There are three ways to select nearly every command (feature) in the program - select from the Pull-down menus, click an icon on the Left-hand toolbox, or type in a two-letter shortcut on your keyboard. Examples of two-letter shortcuts include ZW for Zoom Window or C2 for 2-point Circle. The two-letter shortcuts are listed in the electronic help, and they are shown on the pull-down menus, to the right of each command name. Using some of the more common shortcuts can really reduce your drawing time.

Tip: There are a couple other keys on the keyboard that you will find to be very useful as you draw – the Esc key and the Space Bar.

   Esc Key – The “Escape” key is used to take a step backwards, backing out of a command. For example, if you are placing points to draw a curve, pressing Esc will undo the last point, without canceling the entire command, so you can place it differently.

   Space Bar – Pressing the Space Bar on your keyboard will repeat the previous command. This can be a great shortcut when you need to draw the same object or place the same symbol in multiple places.
Use Aerial Photographs or Bing™ Maps
A fast way to create a pre-incident site plan is to start with an aerial or satellite photograph and draw on top of it. Easy Plan has Microsoft’s Bing™ Maps integrated into it so you can easily find a satellite image of any area. If you bring in a satellite Image from Bing Maps, it will automatically have a 1:1 scale. You can use the Easy Plan dimension tool to measure the side of a building and the measurement will be accurate. If you draw on top of the image to trace a building or other object, you will automatically be drawing at a 1:1 scale.

To search for a Bing image, click the “Import Satellite Photos” on the left-hand tool toolbox.

A new window is displayed with a text box in the lower-left corner. Type an address or the name of a location, such as a hospital or school name in this text box. Within seconds the satellite image is displayed.

Use the slider bar on the left side to zoom in and out to get exactly the image you want. Click the Place button and then click in the diagram where you want to place the image.

Once the image is placed, you can use any of the drawing and editing tools in the program to draw on top of the image and turn it into a pre-fire plan diagram. You can use bold lines to draw attention to buildings, place text, and dimensions. Easy Plan also includes thousands of pre-drawn symbols that you can drop into place to show hydrants, FDCs, utility shut-offs, and more. This is an extremely fast way to create a detailed pre-fire plan diagram!

Tip: Once the image is placed go into Image Edit and Fade the image to make it lighter so all of the other objects such as symbols, text, outline and more will be easier to read.
Drawing Tools

Everything in your diagram will be constructed of basic objects like lines, arcs, curves, circles, text, and so on. Lucky for you, you do not have to actually draw every individual object in your diagrams because most objects you will want to show are part of an aerial photograph or are provided as pre-drawn symbols.

Even with so many symbols provided for you, it is still important that you learn to use the basic drawing commands. You may want to add rectangles to outline buildings and parking lots, place arrows (leaders) to call attention to details, or draw lines and curves to show streets.

The left-hand toolbox includes a variety of commands for drawing basic objects all grouped together in the under the Draw section heading. You can also select any of the Draw commands from the Draw pull-down menu. There are multiple commands for drawing some objects, like arcs, because they can be drawn in different ways depending on what kind of measurements you have.

Descriptions of how to use some of the basic drawing commands will be given in the tutorial, later in this manual.

Placing Symbols

Many of the objects that you place in your diagrams are already pre-drawn for you and included in the program as “symbols.” The symbols are divided up into groups that are shown by icons in the Symbol Manager. Open the Symbol Manager by clicking the icon in the EZ Tools section of the left-hand toolbox.

The top of the Symbol Manager toolbox shows which symbol group is currently displayed. In the figure here, it’s the “Easy Plan” group. If you click the “More” button beside the word Easy Plan, you can select from the other symbol groups including, NFPA 170, and My Symbols, which are symbols that you create.

Many symbol groups have multiple sub-groups that you select by clicking the tabs above the symbol preview window. For example, if you click on Water to select that group, you can then select from the sub-groups: Hydrants, FDC’s, Supply, and so on, as shown here. When you click on a symbol to select it, a larger preview of that symbol is shown at the bottom of the Symbol Manager.
Here is how to add a “Fully Sprinklered” symbol to a diagram.

1. Open Symbol Manager and select Basic symbol category. (This is in the Easy Plan group, if Easy Plan is not current, click “More” and select it.)
2. Click on the desired symbol in the preview window to select it, the Fully Sprinklered symbol, in this case.
3. Move the mouse pointer into the diagram and you will see a preview of the symbol, attached to the pointer.
4. Make sure the Angle Draw 0° is turned on, which is shown when the icon on the upper-toolbar has a green background. This makes it easy to place symbols so they are exactly horizontal or vertical. For some symbols, you may not want Angle Draw 0° turned on, but it is helpful for this sprinkler symbol.

All symbols are drawn at a specific size. For example, a 3’ Door symbol is drawn to be exactly 3’ wide. If you are placing this sprinkler symbol on a very large building, it may appear small. If you select the Dynamic Scale feature, you can change the size of the symbol when you place it in the diagram.

5. Click the Dynamic Scale at Placement icon on the bottom of the Symbol Manager toolbox.
6. Click once in the diagram to place the anchor point for the symbol.
7. Move your mouse to the right and you will see an outline of the symbol that gets larger or smaller as you move the mouse away from the anchor point. If you do not set Dynamic Scale to on, you will not be able to change the symbol’s size.
8. Click again to finish placing the symbol when it has the desired size.
Textures and Hatch Patterns

It is easy to fill an area of your diagram with a pattern or a solid color. You can select from more than 100 textures and hatches, including grass, water, sand, concrete and so on. The Texture-Hatch toolbox is one of the EZ Tools on the left-hand toolbox.

There are four command icons at the top of the Texture-Hatch toolbox that are different methods for placing textures and hatches. You can fill inside existing objects, like rectangles, circles, polygons, by selecting them and using the Hatch Selected command. You can click inside a completely closed area and fill it with the Seed Hatch. You can fill an area of the screen with the Boundary Hatch command by clicking or snapping to boundary points. Hatch Selected, Boundary Hatch, Seed Hatch, and Window Hatch all work the same way, regardless of whether you have chosen to place a Texture, a Hatch or a Solid Fill.

Here is how you can fill a swimming pool with a water texture:

1. Click on the Textures icon in the EZ Tools section of the left-hand toolbox.
2. By default, the list of Textures is automatically displayed. Click on the “Hatch” tab to display the list of “cross hatches,” or to fill an area with a solid color.
3. Scroll through the list of textures until you see Water_3 and click on it.
4. Make sure that “Auto Snap” is turned on, which is shown when the magnet icon at the top of the screen has a green background. If it does not have a green background, click the magnet icon to turn Auto Snap ON.

Tip: With Auto Snap turned on, the mouse pointer is turned in to a circular target. If you position this target so an object or the endpoint of a line is inside it and click your mouse, you will snap exactly to that object.

5. Click on the “Boundary Hatch” icon at the top of the Texture toolbox.
6. Position your mouse pointer so one corner of the pool is inside the Auto Snap target and click to snap exactly to that point.
7. Move clockwise to the next corner of the pool and snap to it.
8. Continue moving around the boundary of the pool, snapping to each corner. Finish by snapping on the initial corner point.
9. Press the Enter key on your keyboard to complete the boundary and place the texture.

**Tip:** If a texture or hatch pattern appears too small or too large, you can change its scale. Click on an existing Hatch or Texture in the diagram, right click on it and select Edit. Enter a larger scale to make the pattern display larger or a smaller scale to make it smaller.

There are other methods you can use to place textures and hatch patterns, so you can choose the one that works best for your diagram. Besides the Boundary Hatch command, there is Seed Hatch, Window Hatch, Hatch Selected, and Select Like Surfaces.
Selecting Objects for Editing

As you draw and place symbols you will want to make changes to your diagram. Before you can perform an editing command, like Move or Copy, you must select the objects in your diagram that you want to change. It’s easy to select a single object, you simply left-mouse click on it. However, you will frequently want to modify a number of objects at once, whether to change their size, move all of them to a new location, or change their properties. Being familiar with the various selection methods makes drawing and editing much faster because you can quickly select just the objects you want to modify. You can see all the selection commands by choosing “Select” from the Edit Pull-down menu.

Tip: When objects are selected, they are displayed in pink and surrounded by blue, square handles.

Tip: To un-select objects, just click your mouse in a blank area of the drawing window.

Using The Mouse To Edit

When objects are selected, a red target symbol and a red square (rotation handle) are displayed near the center of the selected objects. You can use your mouse to manipulate these special handles as shortcut methods to move, rotate, and re-size objects:

You can quickly select a group of objects by enclosing them in a Selection Window. Place your mouse pointer above and to the left of the objects, hold down the mouse button and drag your mouse down and to the right. When all the objects you want to select are completely enclosed in the window, let up on the mouse button.

Similarly, you can select all objects that cross through a selection window by drawing the selection window in the opposite direction - start below and to the left and move your mouse upward, to the right of the objects to select.
**Tip:** If you have a large diagram and you select a small object, you may see it turn pink but not be able to see the selection and rotation handles. Simply use the Zoom Window command to zoom in around the object until the handles are displayed.

**To move the selected objects** - Place your mouse pointer inside the blue selection handles and hold down the mouse button to drag them to a new location. (If you want to snap objects to a precise point, use the Move command by typing MV on your keyboard.)

**To rotate the selected objects** - Place your mouse pointer on the red, square rotation handle near the center of all the selected objects and drag your mouse in a circular motion. (If you want to rotate objects an exact angle, use the Rotate command so you can enter the precise angle.)

**To scale, or resize, the selected objects** – Place your mouse pointer on any of the blue, square selection handles and *hold down* the mouse button to drag them to a smaller or larger size. If you want to resize objects proportionally, not changing their ratio of width to height, place your mouse pointer on a selection handle that is on one of the corners and drag it to the new size.

**Editing Commands**

Once an object or objects are selected, they can be modified with the various Edit commands. Edit commands can be performed either by selecting one of the Edit commands from the Edit pull-down menu, by selecting a command icon from the left-hand toolbox, or for some commands, by using your mouse.

There are commands to Cut, Copy, Paste, Move, Break an opening, Trim or Extend Fillet, and so on. For many editing operations, there is more than one way to perform it, so you can choose the one that gives you exactly the results you want. For example, if you want to make a copy of some objects you can use the standard Copy to the Windows Clipboard or the Multiple Copy command which allows you to make multiple copies of selected objects to an exact location.

**Tip:** Whenever performing an Edit command, be sure to look at the Message Bar at the top of the screen. This is where you will get instructions on what to do next!

Many of the Edit commands require you to choose a reference point, or handle, and a new location for that handle. For example, when you start the Move command, the Message Bar at the top of the screen will prompt you to “Pick Reference Point.” You can click on any point, or snap to grab an exact point like the end of a line. Think of this as the handle by which you will pick up the object. Next you are prompted to “Pick Offset Point.” This point is the new location for the handle. If you wish to move the objects to some exact point, be sure to use Snap commands to accurately grab each of the reference points!

Next, we’ll give specific instructions on how to perform two of the more detailed Edit commands, including Trim/Extend and Break.
**Trim and Extend**

Use the Trim/Extend command when you want to trim or extend an object so it ends exactly at another object. You can use this command to trim or extend lines, continuous lines, arcs, and curves. For example, when creating an intersection you can trim or extend a line that represents one side of a street so it ends exactly at another line.

In this example, we will trim the top horizontal line so it ends exactly at the vertical line. To trim or extend an object to another object:

1. Click on the Trim & Extend icon on the left-hand toolbox, or select the Trim/Extend command from the Edit pull-down menu.
2. Click first on the object to be trimmed, near, but not on the end that is being trimmed.
3. Next, click on the object to which the first object will be trimmed, the vertical line, in this example.

The first object will be trimmed or extended so it ends exactly at the second object that you selected.

**Break**

Use the Break command when you want to break a gap, or hole, in an object. For example, you may want to insert an opening in a wall for a door or window.

1. Select the Break command from the left-hand toolbar or from the Edit pull-down menu.
2. Select the line or object that you want to break. You can click on it or use any of the selection methods.
3. Click or snap on the object where you want the break to begin. This point need not be exactly on the object; the break will start at the point closest to the point you place.
4. Move your mouse and a dynamic preview of the break appears, changing as you move the mouse.
5. Click or snap where you want the break to end. A hole is broken in the object between the two points you selected.

Changing Views
As your diagrams become larger and more complex you will frequently want to change how the diagram is displayed on the screen. That’s where the View, or Zoom, commands come in. You can show the entire diagram on the screen (using the Zoom All Command), but then it may be difficult to see the smaller details. You will learn to zoom in to draw small details and zoom out to make more visible space for placing a large item, like a building.

Tip: You can think of the Zoom commands like using a zoom lens on a camera. Using any of the View commands does not change the actual size of any objects in the diagram, it only changes how they are displayed on the screen. If an object was drawn to be 20’ long and you perform a Zoom Window around it, the object will appear larger on the screen, but it will still be exactly 20’ long.

All of the View Commands can be selected from the View pull-down menu. The most commonly used View Commands can also be selected from the Speedbar, the toolbar that runs across the top of the drawing window. These include:

**Redraw** – Use this command to refresh the screen. If you do some editing and deleting and it looks as if objects have been partially erased, don’t panic, just do a Redraw!

**Zoom All** – Click this button to make the entire diagram fit onto the screen.

**Zoom Window** – This command lets you use your mouse to draw a window around some details in your drawing. The view of that window is then expanded to cover the screen.

**Zoom In** and **Zoom Out** - Use these commands to change the view of the diagram to be incrementally larger or smaller with each click.
**Blot Out and Blot Preferences**

Blot Out is a feature that makes it easy to highlight text, symbols, arrows, and other objects by “blotting out” the objects behind. Blot Out is especially helpful to highlight text drawn on top of an aerial image or a texture.

To apply Blot Out to an object, select it click the Blot Out icon in the View section of the left-hand toolbox. You can also position the mouse pointer on the selected object, *click the right‐mouse button*, and then select Blot Out. Clicking the right‐mouse button brings up a menu of commonly‐used commands, including Blot Out and Blot Preferences.

The “Blot Preferences” command lets you change the settings used with Blot Out for new objects to be drawn. You can select whether to automatically apply “Blot Out” to all future text, dimensions, symbols, and arrows. You can also select whether to always use the diagram background color for blots or select a specific blot color from a pull‐down list.

**Tip:** By default, “Blot Out” is automatically applied to text, dimensions, arrows, and symbols. This means when you first start using Easy Plan, whenever you place one of these items, the image behind it will be blotted out. Select Blot Preferences and uncheck any of these entities if you do not want to apply a blot to that entity.

**Tip:** Changing the Blot Preferences will only affect *new objects* you draw. It does not change how a blot was applied to an entity already placed in the diagram. To change the Blot preferences on an existing entity, click on it to select it and then click your *right‐mouse button* to bring up a menu of commands. Select “Blot Out” to remove the blot completely or select “BlotPrefs” to change the blot color.
Quick Start Tutorial

The purpose of the Quick Start Tutorial is to get you started drawing in the program as soon as possible. This tutorial will introduce all the basic concepts you need to create drawings. It should only take about 20 minutes to complete the example diagram.

There are actually many more commands and methods of drawing and editing that are not discussed here. It’s up to you to practice and experiment with all the other commands. Feel free to add to the sample drawing by placing even more symbols, more text, more dimensions, and so on. You also may want to review the rest of the electronic help for detailed descriptions of each feature.

The Quick Start Tutorial will show you how to complete this diagram.

Tip: As you draw, you will use the left mouse button to set points in the drawing window and the right mouse button to open command sensitive “pop-up” menus. These menus contain commands that allow you to modify or change the object on which you are working. If you have a three-button mouse, pressing the middle button acts the same as pressing the Enter key on the keyboard. In this tutorial, it is assumed that you are using a two-button mouse.
**Getting Started**

First, we’ll open Easy Plan and start our new diagram:

1. Open Easy Plan by clicking its program icon on your computer’s desktop.

2. Once the program opens the “Let’s Get Started” dialog box appears on the screen.

3. Choose the “New” option on the left side. (It may already be selected by default.)

4. Type in “Tutorial” for the drawing name. As you save your diagram, it will be saved with the full name Tutorial.czd. This is the standard file name extension used by Easy Plan, The Fire Zone, and other diagram programs published by The CAD Zone.

5. By default the units are set to Feet and Precision to 0, so only whole feet will be displayed. If you wish to change the units you can use the pull-down lists on the “Let’s get started” dialog box, or go to the Utilities pull-down menu at the top of the screen.

6. For the Approximate Site Size, “Medium” is set as the default. You can choose Small or Large if you expect to be creating a smaller or larger drawing. This setting is just to get you started. The size of your diagram will be automatically expanded as you add to it.

7. Click the OK button to finish setting up the drawing.

**Note:** Using the “New” option and assigning a drawing name activates the Auto Save feature. This causes the diagram to automatically be saved to a backup file every five minutes. If no drawing name is assigned, Easy Plan will prompt you to save the diagram with a file name the first time Auto Save is activated. You should replace this name with something that makes sense for the drawing you are creating.

**Bring in a Satellite Image from Bing Maps**

The first step in creating this pre-fire plan diagram is to locate a satellite image of the desired area in Bing Maps and bring it into the diagram. Then we will “Fade” the image to 60% so it is easier to see the objects we will draw on top of it.

1. Click on the “Import Satellite Photos” icon in the Images-Satellite Photos section of the left-hand toolbar.
For this example, we will use a building that is on the corner of SW Watson Ave and SW Millikan Way, in Beaverton, Oregon. To find satellite photographs in your area, you can enter an exact address, a building name, or an intersection, like we do here.

2. In the lower-left corner of the Bing Maps window, type:
   SW WATSON AVE SW MILLIKAN WAY BEAVERTON OREGON

3. Make sure “Georeferenced” is checked and click “Locate.” (Do NOT click Place yet!)

The intersection is displayed as shown here, centered in the window. We actually want the building in the NW corner of the intersection, so we will “pan” the photograph to get the view we want.

4. Place your mouse pointer in the upper-left corner of the photograph and hold down the left-mouse button. Move your mouse downward and to the right (while holding down the mouse button). Drag the photograph until you have approximately this view:

**Tip:** You can also use the slider bar on the left side of the Bing Maps window to zoom the photograph in or out so you can see more or less of the area.

5. Click the “Place” button in the lower-right corner of the Bing Maps window. It may take a few seconds for Easy Plan to retrieve the photograph and place it in the diagram.

6. Click the “Save” icon to save your diagram.
Now that the satellite photograph is in the diagram, the next thing we want to do is “fade” the image to lighten it. This ensures that the pre-fire plan details we add on top the image are easy to see. When an image is placed, it is automatically put on a specific layer and that layer is “locked” so you do not accidentally select the image whenever you click on top of it. To edit the image, select the Image Edit command first, then click on the image to select it for editing.

7. Select the “Image Edit” command from the Images section of the left-hand toolbox.
8. Click on the satellite image to select it.
9. Use the Image Fade Slider Bar to make the Satellite Image Darker or Lighter. You may want to try a fade value of 30 – 40% for this diagram.
10. Click on “Apply.” Click the “Back” button to close the Image Edit toolbox.

Outline the Building
After the satellite image is placed, we want to use the drawing commands to outline important details like the building. The first step is to establish how you want the lines used to appear by setting Object Properties.

Set Object Properties
There are a number of properties that you can set to change how lines, rectangles, arcs, and other objects are displayed. When you set any of these properties, the settings apply to all objects you draw from that time on, until you change the properties again.

Let’s set the object properties to draw with a color of yellow and thick, solid, line type.

1. Click the “More Colors” icon in the Properties section of the left-hand toolbox and select a yellow color.
2. Click the “Width” icon in the Properties section of the left-hand toolbox. Select a width of 5 Heavy. (It may already be set to this value, by default.)
The line width can be set to a relative value, like 0, 3, or 5. A line that has one of these widths will always appear to have the same thickness, regardless of how you zoom in or out in the diagram. Alternatively, you can specify an absolute thickness, like 4” or 1’. A line drawn with a 4” thickness on a large satellite photograph will appear very thin unless you zoom way in on it.

**Turn On Auto-Align**
The Auto-Align feature is ideal for outlining buildings, parking lots, or other portions of a satellite photograph. It automatically aligns the mouse pointer to draw at 90 degree angles from the first line you draw. When the Auto-Align feature is turned on, the icon on the left-hand toolbox will have a green background.

3. Make sure Auto-Align is turned ON. If the icon on the left-hand toolbox does not have a green background, click on it to turn it on.

**Draw a Continuous Line**
Next, use the Continuous Line command to draw a series of line segments to outline the building.

4. Select the Continuous Line icon from the Draw section of the left-hand toolbox.
5. Click on one corner of the building to start the continuous line. We’ll start on the lower-right corner.
6. Move the mouse pointer to the upper-right corner and click to create the first line segment.
7. Move to the upper-left corner and click again. Notice the mouse pointer is restricted to only move in directions parallel or perpendicular to the original line segment. This is due to the Auto-Align feature.
8. Continue clicking on each corner of the building to outline it with line segments.
9. Once you click on the final corner, click your right-mouse button to bring up a menu of choices. Click “Finish” and the final line segment will be neatly trimmed to finish exactly at the starting line.
Tip: This is a good time to save the diagram. It’s a good idea to get in the habit of saving your diagram every few minutes to make sure you do not lose any time!

1. Select the Save icon on the Speedbar.

Place Symbols
Next, we’ll place symbols in the diagram to show a fire escape, sprinkler system, elevator, hydrants, and so on. Easy Plan includes hundreds of predrawn symbols that you can use to show these objects and many more. All symbols are organized into groups that are shown on the Symbol Manager. You bring up the Symbol Manager by selecting it from the EZ Tools section of the left-hand toolbox.

Auto Snap and Angle Draw
There are two other tools that you will use frequently when placing symbols:

Auto Snap – When Auto Snap is turned ON, Easy Plan will search for a nearby point, such as point on a line, an endpoint, or the center of a circle. If such a point is found (within a certain tolerance), whenever you click the mouse, the program will snap exactly to that nearby point. This is ideal for attaching door symbols, stairs, or elevators to a building wall. Turn Auto Snap OFF if you do not want to attach exactly to lines or points. You know that Auto Snap is turned on if the icon on the upper-toolbar has a green background. Auto Snap is turned ON by default.

Angle Draw – In many cases, you may want to draw or place symbols so they are exactly horizontal or vertical. To do this, turn Angle Draw 0° to ON and the mouse pointer is restricted to only move horizontally and vertically. Similarly, Angle Draw 45° restricts the mouse so it can only move at 45° and 135° from horizontal.

Zoom In Around the Fire Escape
Before placing symbols, let’s adjust the view of the diagram to zoom in around the left wall of the building.

Tip: Your entire diagram should be displayed on the screen now. If not, type ZA on your keyboard to perform a “Zoom All.” Typing the two-letter shortcuts for the zoom commands is a good way to save time!

1. Start the Zoom Window command, either by typing ZW on your keyboard or by selecting it from the upper-toolbar. You will place a window around an area of the diagram. The view of that area is then expanded so you see smaller details.
2. Place your mouse pointer above and to the left of the building. Hold down the button and drag the mouse below and to the right. When the area to expand is enclosed in the window, let up on the mouse.

**Place the Fire Escape Symbol**

Open the Symbol Manager, select the Fire Escape symbol, and place it in the diagram.

3. Click the Symbol Manager button on the EZ Tools section of the left-hand toolbox.

4. Click the “Basic” button on the Symbol Manager to display the symbols contained in that group (if they are not already displayed).

5. Click on the “06_Fire Escape L” icon to select it. A larger preview of the symbol is displayed at the bottom of the Symbol Manager.

6. Move the mouse pointer onto the drawing screen and notice the “ghost image” that represents the symbol attached to the “cross hair” mouse pointer. (The cross hair shows that the “Auto Snap” feature has been turned on.) If you do not see a cross hair pointer, click the Auto Snap button on the Speedbar to turn it on.

7. Move the mouse pointer’s cross hairs over the wall where you want to place the symbol.

8. Click the left-mouse button to snap directly to the wall and set the symbol’s anchor point.

9. Move the mouse and notice that the symbol box dynamically rotates about the anchor point, as shown here.
Select the symbol and move the mouse pointer into the drawing window. A ghost image is displayed.

Make sure Auto Snap is turned on, click near the wall to snap the symbol’s first anchor point to the wall.

As you move the mouse, the symbol rotates around the anchor point. Click again to finish placing it.

10. Move the mouse pointer downward and align it with the wall. If the mouse will only move exactly horizontally or vertically, click on the Angle Draw 0° command on the upper-toolbar. Turning this feature off will allow you to move the mouse freely in any direction. Angle Draw is turned off when the icon has a blue background.

11. Click the left-mouse button when the cross hair is on the wall to snap the symbol to it. When you finish placing the fire escape symbol, it should look like the one in the following figure.

Tip: Whenever you are in the middle of a command, like placing a symbol, if you click your mouse, but don’t like the result, press the Esc key on your keyboard to undo that click. Whenever you are performing a command, pressing Esc backs up one step. You can use Esc to undo points until you click the final time to place the symbol.

Change the View with Zoom All
Since we are finished working in the area around the fire escape, click the Zoom All command on the upper-toolbar to display the entire diagram. You will frequently use Zoom commands to adjust the view. You can even click a Zoom icon and change the view in the middle of another command.

We turned off the display of the aerial photograph so it is easier to see the symbol.
Place Additional Symbols

You use the same method to place any of the pre-drawn symbols in your diagram. There are also other options on the Symbol Manager toolbox which you can use to mirror, explode, change the color, and change the size of symbols as you place them. You should experiment with them as you place more symbols in your diagram.

Now let’s apply this method to place some more symbols, as shown in the next figure. We’ll place the sprinkler symbol and hydrant first.

1. We want to place these symbols exactly horizontal, so make sure Angle Draw 0° is turned on. This will restrict the mouse to only move horizontally and vertically, making it easier to align the symbols.
2. Select the Partially Sprinklered symbol from the Basic symbol category.
3. Click in the building to anchor it.
4. Move the mouse to the right and click again to finish placing the symbol.

Next, let’s place the hydrant symbol, but let’s make it larger.

5. Select the Hydrant symbol from the Basic category. (There are other hydrant symbols in the Water category that you may prefer to use.)
6. Click the “Dynamic Scale at Placement” icon at the bottom of the Symbol Manager. With this option turned on, you can change the size of symbols as you place them.
7. Click in the diagram to place the anchor point for the Hydrant, just as with previous symbols.
8. Move the mouse to the right. (Because Angle Draw 0° is still turned on, mouse movement is restricted to be exactly horizontal or vertical.)
9. Notice that the ghost image of the hydrant gets larger or smaller as you move the mouse.
10. When it has the desired size, click again to finish placing it.
Select the hydrant symbol and click to anchor it near the street.

Since Dynamic Scale is turned ON, now you can change the symbol’s size. Move the mouse to the right and see it get larger.

When the hydrant has the desired size, click again to finish placing it.

Next, select the FDC symbol and place it on the West side of the building, just as you did the Fire Escape. You will want to make sure Angle Draw is turned OFF for this symbol, since it is not placed horizontally. The icon should have a blue background. You may want to leave Dynamic Scale turned on so you can make the FDC larger.

Finally, we will place the elevator symbol along the North wall.

1. You may want to use a Zoom Window to zoom in around that area of the building.
2. From the Basic symbol group select the Elevator symbol.
3. Position it on the North wall of the building and click the left-mouse button to anchor the symbol. Move the mouse to the right, align it to the wall and click again to place the symbol.

This places the elevator symbol, but due to the way the symbol is orientated, it is outside the building! We’ll use the mouse to select the symbol and move it inside.

4. Click on the elevator symbol to select it. When objects are selected, they are displayed in pink with eight blue “handles” around them.
5. Position the mouse pointer inside the handle points and hold down the left-mouse button.
6. While holding down the mouse button, drag the mouse and notice the symbol being moved.
7. When the symbol is at the desired location, inside the building, let up on the mouse button.
8. Click anywhere in the diagram, away from other objects to “un-select” the elevator. You can also press the Esc key on the keyboard.
9. Click the Back button on the bottom of the Symbol Manager to close the toolbox.
Tip: This is a good time to save the diagram. Be sure to save your diagram every few minutes!

Symbols are all pre-drawn to have a certain size. Depending on the size of your building, some symbols may appear too small or too large. We saw how to use the Dynamic Scale option to scale a symbol as you place it. It’s also easy to change the size of a symbol or other object that is already placed in your drawing.

**Moving and Sizing Symbols**

Let’s make the sprinkler symbol larger. First, adjust your view to make it easier to work with the symbol:

1. Perform a Zoom Window around the interior of the building (This command was described earlier.)
2. Click on the sprinkler symbol to select it. The selected object is displayed in pink with blue squares, called “selection handles” surrounding it.
3. Position your mouse pointer on one of the corner handles.
4. Hold down the mouse button and drag the mouse diagonally away from the selected object and it will get larger.
5. When it has the desired size, let up on the mouse button.
6. To de-select the symbol, press the Esc key or just click in the diagram, away from any other objects.
7. Type ZA on the keyboard to perform a Zoom All.

**Tip:** These methods of moving and re-sizing work on all objects in your diagram, not just symbols. Remember before you can move, copy, rotate, or re-size any object, you must select them by clicking on them, or by enclosing them in a selection window.

**Making Copies**

Next, we will make a copy of the Elevator symbol using the Copy (to clipboard) command and place it next to the existing elevator symbol. First, let’s expand the view of that area in order to make it easier to work.

1. Use the Zoom Window command to zoom up on the upper area of the building.
2. Click on the existing elevator symbol to select it.
3. Click the Copy (to Clipboard) icon on the Speedbar.
4. Click the Paste icon on the Speedbar.
5. Move the mouse pointer back onto the drawing screen and position the cross hair to the right of the original elevator.
6. Click the left-mouse button to place the copy of the elevator.
7. If you don’t like the new elevator’s position, click on it to select it and then use the mouse to move it.
8. Click in a blank area of the diagram to de-select the symbol.

Alternatively, you could select one of the other Copy Commands on the Edit pull down menu. These commands allow you to choose a reference point, or handle, to use for snapping the copy onto a specific point. They also allow you to make multiple copies of an object in rows and columns, or in a radial pattern.
Add Labels

Next, let’s add some text to the diagram, using the Text entry toolbox, as shown in the next figure. First, type ZA (or select Zoom All from the Speedbar) to display the entire drawing on the screen.

1. Select the “Text” command from the Text - Dimension section of the left-hand toolbox.
2. Click in the Enter Text field of the dialog box and type:
   24 Hour Fitness
3. Move the mouse pointer back into the diagram and you will see a box that shows the outline of the text
4. Change the text height by clicking on the large “A” or small “a” text buttons. Alternatively, you can type a value in the box for the text height. For this example, set the text height to 12’.
5. Make sure the “Show Arrow” box is not checked. You can also set other options, for example, change the text color to red and change the font.
6. Move the mouse pointer back onto the drawing screen and notice a box attached to the mouse pointer that represents the text.
### Placing Text

1. Position the mouse pointer where you want to place the lower-left corner of the text and click. This anchors the text at that point.
2. Move your mouse and notice the text rotates around the anchor point.
3. Move your mouse horizontally to the right and click again to finish placing the text. Turn on the Angle Draw 0° mode (if it is not already on) to ensure you place the text exactly horizontal.
4. Following these steps, you can continue to place additional text in the diagram.
5. Click the “Back” button on the Text dialog box when you want to stop drawing text.

Your diagram should now look like the one in this figure, including the new text we just added.

**Tip:** If you delete a text label or a dimension, it may look like a large area of the diagram has been erased. Just use Redraw to refresh the diagram.

### Placing a Dimension

Next, we will dimension the building.

1. Make sure that Auto Snaps is turned ON so you can snap exactly to the corners of the building and ensure a precise measurement.

We will place dimensions that are aligned with the walls of the building, so we do not want mouse movement to be restricted to by the Angle Draw feature.
2. Click the Angle Draw 0° button on the Speedbar to turn it OFF (assuming it was on before). When it is off, it has a blue background.

3. Select the Dimension command from the Text - Dimensions section of the left-hand toolbox.

4. Just as you did when placing text, adjust the Dimension text height by clicking the “Large A” or “Small A” buttons on the Dimension toolbox. Set it to 12’.

5. Also, select these settings:
   a. “Text Only” option is NOT checked.
   b. “Horz Text” (horizontal text) IS checked.
   c. “Single Click Dim” IS NOT checked.
   d. Set the color to red.
   e. “Direction” is set to Aligned. This means the dimension will measure the true distance between two points, rather than a horizontal or vertical distance.

6. Position the mouse pointer “cross hairs” at the upper-right corner of the building (Point A in the figure) and click your mouse to snap to the first dimension point.

7. Move the mouse pointer downward to point B and click again.

8. Next, move the mouse pointer to the right and notice a ghost image of the dimension line with a box attached that represents the dimension text.

9. When the dimension line is positioned at the desired location, click the left-mouse button a third time to place the text at that location.

10. Place additional dimensions, as needed.

---

Set the Dimension options, then:

A. Snap to corner A

When you move the mouse, you see the dimension take shape. Click a third time to place the text.

B. Snap to corner B

C. 24 Hour Fitness

The final dimension

Click the Dimension Tool button to place another dimension.
The satellite image that we brought in to start this diagram has a 1:1 scale, meaning everything is shown at the actual, real-world, size. The dimensions we drew show this building to be 234’ x 175’.

As long as the Dimension toolbox is open, you can continue to place more dimensions. Click the Dimension Tool button at the top of the toolbox to start placing another dimension. Click the “Back” button on the dimension dialog box to stop drawing dimensions.

**Tip:** If you perform a Zoom or some other command, it will take you out of Dimension mode. Click the Dimension Tool button at the top of the dialog box to place another dimension. This is where you can also select other dimension modes, such as Angular Dimension and Radial Dimension.

**Tip:** If you haven’t already done so, now is a good time to save the diagram.

11. Select the Save button on the Speedbar to save your diagram.

**Printing Your Diagram**

To output your diagram to a printer, use the Print command found on the File menu or select the Print icon from the top of the screen at the left of the Speedbar. With this command, you can set the scale and orientation of the diagram as it will appear on the paper.

1. Make sure your printer is turned on and has paper.
2. Select the Print command from the Speedbar, or by choosing it from the File pull-down menu.

The Print dialog box will appear where you can select from many different settings that change how your diagram is to be printed.

The default Print settings use a portrait paper orientation and automatically scale the diagram to fit on the paper. You can always enter a specific print scale if you want to print the diagram at an exact size so you can take measurements off the paper print of the diagram.

The Print dialog box with default settings. The program calculated the drawing scale needed to fit it to the paper.
3. Select a Landscape paper orientation so this diagram fits better on the paper. This setting will be different depending on the shape of each diagram.

4. If desired, adjust the print scale by entering a value on the Print toolbox. In this example, we choose the Scale option, entered a value of 55', then clicked “Update” to update the preview window.

5. When the diagram appears the way you want it in the preview window, click on the Print button.

Since we drew the building to the actual measurements of 234’ long, it obviously has to be scaled down to fit onto a sheet of paper. By default, the Print dialog box is set up to print the diagram with the “Fit to Paper” option. This means the program calculates the best scale to use based on the size of paper you have selected. In this figure, we chose the “Scale” option and entered an exact scale of 1” = 55’. By entering an exact scale, it makes it easier to take measurements from the printed diagram.

**Using a Specific Scale**

If you want to use a specific scale that is a smaller value than the one calculated for “Fit to Paper,” the diagram will no longer fit on one page. In this case, the drawing is “tiled” by splitting it across multiple sheets. Each sheet of paper in the preview window is shown by dashed, red lines. You can use your mouse in the preview window to drag the drawing so it fits differently on the pages. Many departments use Print Tiling to print out large maps or commercial facilities on multiple sheets of paper and then tape them together to hang them up.
Let’s see how Print Tiling works with our tutorial drawing.

1. Open the Print dialog box.
2. Make sure the Scale option is selected.
3. Enter a Real World scale value of 25' so the scale is 1" = 25'.
4. Click “Update.”

The preview window shows 9 boxes, outlined in red. These represent the pages across which the diagram will be tiled.

5. Place your mouse pointer on the diagram in the preview window and hold down the mouse button.
6. In the figure shown, we used the mouse to drag the diagram so the building is centered in the third and fifth tiles. You can place the diagram on any of the pages.
7. Click Print to print the diagram on the pages shown.

**Printing a Specific View**

You can also choose to print a specific view of a diagram, such as a zoomed in view of some details. Use the View commands to get the view you want on the screen first and then open the Print dialog box.

1. Use the Zoom Window command to zoom in on the lower-left corner of the building.
2. Click the Print button to bring up the Print dialog box.
3. Click the option to print “Current View.”
4. Click the Print button to print that view.

**Congratulations! You have just completed your first diagram with Easy Plan!**

As you draw your own diagrams, refer to the electronic Help (Help pull-down menu) and the training movies (Learning Center) for more information about each feature.